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About DMTI Spatial 

DMTI Spatial, a Digital Map Products company, is the Canadian market leader in location based 

information and data quality. For more than 20 years, DMTI Spatial has been providing industry leading 

location economics and Master Address Management (MAM) solutions to Global 2000 companies and 

government agencies. DMTI Spatial is the creator of market leading CanMap® mapping solutions, award-

winning Location Hub® and maintains the gold standard for GIS location-based data in Canada. DMTI 

Spatial is headquartered in Richmond Hill, Ontario. Learn more at www.dmtispatial.com  

 

Technical Support, Error Reporting & Product Enhancement Services 

DMTI Spatial is committed to building the best products possible for our customers.  By using our data 

every day in your mission critical application you are our best source for product refinement.  Please let 

us know if you have an enhancement request or found an error in any of our products so that we can 

make the correction for the next release. 

 

This is your opportunity to provide feedback directly to the DMTI Spatial Product Development Team.  

Please be as specific as possible so that we can improve our products quickly and accurately.  To submit 

an error or request technical assistance please visit our website at: http://www.dmtispatial.com/ 

 

Contact Information 

DMTI Spatial Inc. 

30 Leek Crescent, Suite 202 

Richmond Hill, Ontario 

L4B 4N4 Canada 

 

Telephone: 905-948-2000 

Toll Free: 1-877-477-DMTI (3684) 

Fax: 905-948-9404 

Web Site: www.dmtispatial.com NEOP 
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Trademarks and Notices 

© 2024 DMTI Spatial Inc., all rights reserved. 

 

™ DMTI Spatial Inc. unregistered trademarks:  

DMTI Spatial™; Connect. Analyze. Act. ™ ; Unique Address Identifier™ ; Unique Unit Address Identifier™ 

(UUAID™) ; Location Intelligence™ ; Profit from Location Intelligence™ ; We help you unlock the power of 

location economics™ ; Unlock the power of location economics with news you can use; all rights 

reserved. 

 

 ® DMTI Spatial Inc. registered trademarks: 

CanMap®, Location Hub® and UAID®, all rights reserved. 

 

Any other products, corporate slogans and/or catch-phrases and company names mentioned herein may 

be trademarks of their respective companies. Mention of third-party products is for informational 

purposes only and constitutes neither a recommendation nor an endorsement. 

 

Postal CodeOM is an official mark of Canada Post Corporation. 

 

Digital Topographic Data produced under License from Her Majesty the Queen in Right of Canada, with 

permission of Natural Resources Canada and The Queen in Right of Manitoba.  

http://www.dmtispatial.com/
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About CanMap® Postal CodeOM Suite 

The CanMap Postal CodeOM Suite is comprised of the following postal products:  

 

The CanMap Postal CodeOM File - Multiple Enhanced Postal Code (MEP) product is a precision-based 

point file representing over 1 million postal codes across Canada. The Multiple Enhanced Postal Code 

product allows for a one to many relationship. For example, one postal code may represent more than 

one postal code location. Inferred MEPs are postal codes in the MEP Product that don’t directly 

represent an address. Inferred MEPs are often postal codes for mailing distribution points (i.e a post 

office). We include these in our spatial MEP file to have a more complete representation of all the postal 

codes in Canada. 

 

The CanMap Postal CodeOM File – Local Delivery Unit (LDU) Boundaries product is a polygon file 

representing the geographic location of the 6 digits postal code. The boundary file is generated from 

point addresses with six-digit postal codes attribute assignments.  The LDU Boundaries allow for a many 

to many relationship. For example, one postal code may be represented by more than one LDU 

boundary and one LDU boundary may be associated with multiple postal codes. 

 

The CanMap Postal CodeOM File - Forward Sortation Area (FSA) Boundaries product represents the first 

three characters of a postal code indicating a specific geographic area and is aligned to nest with 

CanMap Postal CodeOM File - LDU Boundaries and CanMap Postal CodeOM File - Multiple Enhanced Postal 

Code product. 

 

Note: The CanMap Postal CodeOM File - Unique Enhanced Postal Code (UEP) product is sold separately. 
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Layer Properties 

CanMap Postal CodeOM File - Multiple Enhanced Postal Codes  
 

Property Description 

Coverage National 

Currency August 15, 2024 

Level of Accuracy Ranging from CanMap® Streetfiles to PPN centroid. 

Projection All layers are displayed as unprojected Longitude – Latitude 

Datum All layers are in WGS84 datum 

Format ESRI, MapInfo, ASCII1 

 
 
CanMap Postal CodeOM File - Local Delivery Unit Boundaries and  
CanMap Postal CodeOM File - Forward Sortation Area Boundaries 
 

Property Description 

Coverage National 

Currency August 15, 2024 

Projection All layers are displayed as unprojected Longitude – Latitude 

Datum All layers are in WGS84 datum 

Format ESRI, MapInfo 

  

 
1 Custom formats available upon request.  Refer to Appendix A: File Extensions for more information regarding file 

extensions. 
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About CanMap® Postal CodeOM Suite (cont’d) 

Layer Naming Conventions 

The CanMap Postal CodeOM File - Multiple Enhanced Postal Code product is organized into the following 

directory structure and uses the following directory and file naming conventions: 

 

CanMap Postal CodeOM File - Multiple Enhanced Postal Code 

 

example:                                \Mep\ON\ONmep 

 

 

 

Product 

Directory 

Geographic Area 

Directory 

Geographic Area 

Abbreviation 

File Content 

Abbreviation 

MEP ON ON mep 

 

The CanMap Postal CodeOM File - Local Delivery Unit Boundaries product is organized into the following 

directory structure and use the Postal Code Areas (PCA) file naming convention: 

 

Geographic Area Abbreviation + Layer Content Abbreviation = Layer Name 

  

http://www.dmtispatial.com/
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CanMap Postal CodeOM File - Local Delivery Unit Boundaries 

 

example:                                \LDU\ON\ONldu 

 

 

 

Product 

Directory 

Geographic Area 

Directory 

Geographic Area 

Abbreviation 

File Content 

Abbreviation 

LDU ON ON ldu 

 

CanMap Postal CodeOM File - Forward Sortation Area Boundaries 

 

example:                                 \FSA\ON\ONfsa 

 

 

 

Product 

Directory 

Geographic Area 

Directory 

Geographic Area 

Abbreviation 

File Content 

Abbreviation 

FSA ON ON fsa 

 

 

The geographic area directory indicates the geographic coverage of the layer, for example ON = Ontario.  

 

The geographic area represents DMTI Spatial’s standard geographic areas.  For more information refer to 

the following file and field names in the Canada Directory included with the CanMap Postal CodeOM 

Suite. 

http://www.dmtispatial.com/
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About CanMap® Postal CodeOM Suite (cont’d) 

CanMap Postal CodeOM File - Multiple Enhanced Postal Code 

 

Layer Name Field Name Description 

AREAmep\Canada\CANtop Full_Name Topographic Coverage Area Name 

AREAmep\Canada\CANtop Name Topographic Coverage Area Abbreviation 

 

CanMap Postal CodeOM File - LDU Boundaries 

 

Layer Name Field Name Description 

AREAldu\Canada\CANtop Full_Name Topographic Coverage Area Name 

AREAldu\Canada\CANtop Name Topographic Coverage Area Abbreviation 

 

CanMap Postal CodeOM File - Forward Sortation Area Boundaries 

 

Layer Name Field Name Description 

AREAfsa\Canada\CANtop Full_Name Topographic Coverage Area Name 

AREAfsa\Canada\CANtop Name Topographic Coverage Area Abbreviation 

 

CanMap Postal CodeOM Suite contains the following general content directories: 

 

CanMap Postal CodeOM File - Multiple Enhanced Postal Code 

 

Directory Name Description 

Canada Canada Directory 

MEP Multiple Enhanced Postal Code Directory 

 

CanMap Postal CodeOM File - Local Delivery Unit Boundaries 

 

Directory Name Description 

Canada Canada Directory 

LDU Local Delivery Unit Boundaries Directory 

 

CanMap Postal CodeOM File - Forward Sortation Area Boundaries 

 

Directory Name Description 

Canada Canada Directory 

FSA Forward Sortation Area Directory 

http://www.dmtispatial.com/
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About CanMap® Postal CodeOM Suite (cont’d) 

Layer Contents 

The CanMap Postal CodeOM Suite contains the following additional layers:  

 

Canada Directory  

 

Layer Name Description Feature Type 

CANacb Area Code Boundaries Polygon 

CANcap Capital Cities Point 

CANprv  Provincial/Territorial Boundaries Polygon 

CANrmn Regional Municipality Boundaries Polygon 

CANtop Topographic Coverage Areas Polygon 

CANtzs Time Zones (Standard Time) Polygon 

CANtzd Time Zones (Daylight Savings Time) Polygon 

CANwat  National Water Polygon 

 

The Canada Directory is included with the CanMap Postal CodeOM Suite products. For more information 

regarding the Canada Directory refer to the Canada Directory User Manual included with CanMap Postal 

CodeOM Suite.  

 

Topological Reference Directory 

 

Layer Name Description Feature Type 

AREAwatr Major and Minor Water Body Reference  Polygon 

AREAwatl Minor Water Line Reference Polyline 

AREAprks Park Boundary Reference  Polygon 

AREArail Rail and Transit Line Reference Polyline 

 

The Topological Reference Directory is included with the CanMap Postal CodeOM File - Local Delivery Unit 

Boundary product.  These spatial data layers are included as a topological reference to the LDU polygons. 

No attribute information is included for these spatial reference layers.  If you wish to obtain the full 

CanMap® Data Product for any of these layers, please contact DMTI Spatial. 
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CanMap Postal CodeOM File - Multiple Enhanced Postal Code Directory 

 

Layer Name Description Feature Type 

AREAmep Multiple Enhanced Postal Code Points (Active records) 

AREAmep_retired Multiple Enhanced Postal Code Points (Retired records) 

AREAp2c Postal To Census Translation Table Database file (Active Records) 

AREAp2c_retired Postal To Census Translation Table Database file (Retired records) 

 

CanMap Postal CodeOM File - Local Delivery Unit Boundaries Directory 

 

Layer Name Description Feature Type 

AREAldu LDU Boundaries Polygons 

AREAlut Postal Code Lookup Table Database file 

 

CanMap Postal CodeOM File - Forward Sortation Area Boundaries Directory 

 

Layer Name Description Feature Type 

AREAfsa FSA Boundaries Polygons 
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Data Dictionary 

CanMap® Postal CodeOM File - Multiple Enhanced Postal Codes 

Layer Location:  \MEP\AREAmep 

 

Layer Structure2 

Field Name Field Type Field Size Description 

MEP_ID Integer 9 Multiple enhanced postal code point unique identifier.  Used 

to link to the Postal To Census Translation Table 

POSTALCODE Character 6 Postal Code data with no space between the FSA and LDU. 

(i.e. L1R2H2) 

POST_CODE Character 7 Postal Code data with a space between the FSA and LDU (i.e. 

L1R 2H2) 

SLI Integer 1 Single Link indicator (Identifies main postal code record when 

multiple records exist).   

PROV3 Character 2 2 letter alpha abbreviation (Canada Post) according to the 

first letter of the postal code (i.e. L1R2H2 = ON) 

COMM_NAME Character 68 Community name 

MAF_ID Integer 9 Uniquely identifies a municipal amalgamation boundary 

BIRTH_DATE Character 8 Date when the postal code became active (YYYYMMDD 

format).   

RET_DATE Character 8 Date when a postal code was retired or no longer in use by 

Canada Post Corporation (YYYYMMDD format) 

DOM_DELMDE Character 2 Dominant Delivery Mode Type identifying the primary type of 

delivery service for Active Postal Code records only 

DEL_M_ID Character 6 Dominant Delivery Mode Identifier 

TOTAL_POC Integer 5 Total Points of Call – the total number of points of call 

(apartments, businesses, houses and farms) served by the 

postal code for all delivery mode types for Active Postal Code 

records only 

POC_APART Integer 5 Points of Call for Apartments – the total number of 

apartments served by the postal code for all delivery mode 

types for Active Postal Code records only 

 
2 Please note that the field sizes may vary for ASCII tab delimited format. 
3 For more information refer to Appendix B: Canadian Provincial and Territorial Codes and Abbreviations 

http://www.dmtispatial.com/
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POC_BUS Integer 5 Points of Call for Businesses – the total number of businesses 

served by the postal code for all delivery mode types for 

Active Postal Code records only 

POC_HOUSE Integer 5 Points of Call for Houses – the total number of houses served 

by the postal code for all delivery mode types for Active 

Postal Code records only 

POC_FARM Integer 5 Points of Call for Farms – the total number of farms served by 

the postal code for all delivery mode types for Active Postal 

Code records only 

TOTAL_CC Integer 5 Total Consumers’ Choice – the total number of points of call 

(apartments, businesses, houses and farms) served by the 

postal code where consumers wish to receive unaddressed 

mail for all delivery mode types for Active Postal Code 

records only 

CC_APART Integer 5 Consumers’ Choice for Apartments – the total number of 

apartments served by the postal code where consumers wish 

to receive unaddressed mail for all delivery mode types for 

Active Postal Code records only 

CC_BUS Integer 5 Consumers’ Choice for Businesses – the total number of 

businesses served by the postal code where consumers wish 

to receive unaddressed mail for all delivery mode types for 

Active Postal Code records only 

CC_HOUSE Integer 5 Consumers’ Choice for Houses – the total number of houses 

served by the postal code where consumers wish to receive 

unaddressed mail for all delivery mode types for Active Postal 

Code records only 

CC_FARM Integer 5 Consumers’ Choice for Farms – the total number of farms 

served by the postal code where consumers wish to receive 

unaddressed mail for all delivery mode types for Active Postal 

Code records only 

PC_COUNT Integer 5 Total number of Postal Code point records associated with 

each postal code 

POSITION Integer 2 Identifies the method used to geographically position the 

interpolated coordinate 

LONGITUDE Decimal 11,6 Interpolated longitude in decimal degrees 

LATITUDE Decimal 11,6 Interpolated latitude in decimal degrees 

CANMAPID Integer 9 ID to reference to CanMap street file 

HP_LONG Decimal 11,6 High Precision longitude coordinate 

HP_LAT Decimal 11,6 High Precision latitude coordinate 

http://www.dmtispatial.com/
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PDC Integer 2 Position Determination Code indicating the method used to 

geographically position the High Precision coordinate 

MULTI_ST Integer 1 Flag indicates where a postal code is associated to multiple 

streets (1 means multiple streets, 0 means single street) 

 

NOTE:  Where high precision coordinates are not available, an interpolated set of coordinates will be 

provided to ensure column completeness for mapping. These records can be identified by querying 

where PDC = 0.   

 

Dominant Delivery Mode (DOM_DELMDE) 

 

Delivery Mode Type Description 

CF Call For 

DR Direct 

GD General Delivery 

LB Lock Box 

LC Letter Carrier 

MR Mobile Route 

RR Rural Route 

SS Suburban Service 

 

Each Postal Code can have more than one Delivery Mode Type.  Dominance for this field is based on the 

highest total combined Points of Call (PoCs) for each Delivery Mode Type.   

 

For example:  A0A1H0 has two delivery mode types; GD and LB.   

• GD has a total of 41 PoCs (4 businesses and 37 homes). 

• LB has a total of 85 PoCs (5 businesses and 80 homes).   

Since the LB delivery mode type has a combined number of PoCs larger than the  

GD PoC, it would be deemed the dominant type therefore appearing in the DOM_DELMDE field for the 

postal code A0A1H0. 
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Point of Call (POC) and Consumers’ Choice (CC) Descriptions4 

 

Type Description 

APART A point of call category that includes self-contained residential units within a high-rise or 

low-rise multiple-unit building of three or more such units, that share a common main 

entrance to the building. If a business is operated from an apartment which is also used as 

a residence, the point of call is to be classified as an apartment. 

BUS A point of call category that includes buildings and structures where the primary activity is 

commercial, industrial or institutional (institutional includes but is not limited to churches, 

hospitals, nursing homes, and schools). If a business is operated from a house or 

apartment which is also used as a residence, it is to be classified as a house or apartment 

as the case may be. 

HOUSE A point of call category that includes residential dwellings that may be detached, semi-

detached or attached in a row. These dwellings have separate entrances and may be 

horizontal (in a row) or vertical (one on top of the other). If a business is operated from a 

house that is also used as a residence, the point of call is to be classified as a house. 

FARM A point of call category that includes residential and business buildings associated with a 

defined area of land (ex. fields) used to raise crops, animals or fish. The point of call does 

not necessarily have to belong to any farming association to be classified as a farm. 

 

  

POSITION  

 

Position Code Description 

1 Block-face representative point from CanMap® streets – Higher precision interpolated; 

the postal code address range geocoded to street segment(s) within the FSA and 

Municipal boundary. 

2 Block-face representation from CanMap® streets – Lower precision interpolated; the 

postal code address range geocoded to closest address on street segment(s) and within 

the FSA boundary. 

3 Postal Code placed to CanMap Postal CodeOM File - Local Delivery Unit (LDU) centroid. 

4 Postal Code placed to CanMap Postal CodeOM File - Forward Sortation Area (FSA) 

Centroid. 

5 Postal Code placed to CanMap Placename (PPN) centroid. 

 

 

 

 

 
4 Source: Canada Post Corporation, 2015.  Website: http://www.canadapost.ca/CPC2/addrm/hh/doc/about-e.asp 

http://www.dmtispatial.com/
http://www.canadapost.ca/CPC2/addrm/hh/doc/about-e.asp


      

© 2024 DMTI Spatial Inc. All rights reserved 

www.dmtispatial.com 

Page 16/42 

 

         

Position Determination Code (PDC) 

 

PDC Description 

10 Centroid of Building Footprint 

11 Building/Unit Entrance (Main) 

12 Building Driveway 

20 Centroid of Parcel 

21 Inside Parcel 

22 Along Parcel Front Line 

 

Table Content: 
 
The Multiple Enhanced Postal Codes product contains all Active postal codes for a period valid one 
month from the release data. 
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Data Dictionary (cont’d) 

CanMap® Postal CodeOM File - Multiple Enhanced Postal Codes Retired 

Layer Location:  \MEP\AREAmep_retired 

Layer Structure5 

Field Name Field Type Field Size Description 

MEP_ID Integer 9 Multiple enhanced postal code point unique identifier.  Used 

to link to the Postal To Census Translation Table 

POSTALCODE Character 6 Postal Code data with no space between the FSA and LDU. 

(i.e. L1R2H2) 

POST_CODE Character 7 Postal Code data with a space between the FSA and LDU (i.e. 

L1R 2H2) 

SLI Integer 1 Single Link indicator (Identifies main postal code record when 

multiple records exist).   

PROV6 Character 2 2 letter alpha abbreviation (Canada Post) according to the 

first letter of the postal code (i.e. L1R2H2 = ON) 

COMM_NAME Character 68 Community name 

MAF_ID Integer 9 Uniquely identifies a municipal amalgamation boundary 

BIRTH_DATE Character 8 Date when the postal code became active (YYYYMMDD 

format).   

RET_DATE Character 8 Date when a postal code was retired or no longer in use by 

Canada Post Corporation (YYYYMMDD format) 

DOM_DELMDE Character 2 Dominant Delivery Mode Type identifying the primary type of 

delivery service for Active Postal Code records only 

DEL_M_ID Character 6 Dominant Delivery Mode Identifier 

TOTAL_POC Integer 5 Total Points of Call – the total number of points of call 

(apartments, businesses, houses and farms) served by the 

postal code for all delivery mode types for Active Postal Code 

records only 

POC_APART Integer 5 Points of Call for Apartments – the total number of 

apartments served by the postal code for all delivery mode 

types for Active Postal Code records only 

 
5 Please note that the field sizes may vary for ASCII tab delimited format. 
6 For more information refer to Appendix B: Canadian Provincial and Territorial Codes and Abbreviations 

http://www.dmtispatial.com/
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POC_BUS Integer 5 Points of Call for Businesses – the total number of businesses 

served by the postal code for all delivery mode types for 

Active Postal Code records only 

POC_HOUSE Integer 5 Points of Call for Houses – the total number of houses served 

by the postal code for all delivery mode types for Active 

Postal Code records only 

POC_FARM Integer 5 Points of Call for Farms – the total number of farms served by 

the postal code for all delivery mode types for Active Postal 

Code records only 

TOTAL_CC Integer 5 Total Consumers’ Choice – the total number of points of call 

(apartments, businesses, houses and farms) served by the 

postal code where consumers wish to receive unaddressed 

mail for all delivery mode types for Active Postal Code 

records only 

CC_APART Integer 5 Consumers’ Choice for Apartments – the total number of 

apartments served by the postal code where consumers wish 

to receive unaddressed mail for all delivery mode types for 

Active Postal Code records only 

CC_BUS Integer 5 Consumers’ Choice for Businesses – the total number of 

businesses served by the postal code where consumers wish 

to receive unaddressed mail for all delivery mode types for 

Active Postal Code records only 

CC_HOUSE Integer 5 Consumers’ Choice for Houses – the total number of houses 

served by the postal code where consumers wish to receive 

unaddressed mail for all delivery mode types for Active Postal 

Code records only 

CC_FARM Integer 5 Consumers’ Choice for Farms – the total number of farms 

served by the postal code where consumers wish to receive 

unaddressed mail for all delivery mode types for Active Postal 

Code records only 

PC_COUNT Integer 5 Total number of Postal Code point records associated with 

each postal code 

POSITION Integer 2 Identifies the method used to geographically position the 

interpolated coordinate 

LONGITUDE Decimal 11,6 Interpolated longitude in decimal degrees 

LATITUDE Decimal 11,6 Interpolated latitude in decimal degrees 

CANMAPID Integer 9 ID to reference to CanMap street file 

HP_LONG Decimal 11,6 High Precision longitude coordinate 

HP_LAT Decimal 11,6 High Precision latitude coordinate 

http://www.dmtispatial.com/
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PDC Integer 2 Position Determination Code indicating the method used to 

geographically position the High Precision coordinate 

MULTI_ST Integer 1 Flag indicates where a postal code is associated to multiple 

streets (1 means multiple streets, 0 means single street) 

 

NOTE:  Where high precision coordinates are not available, an interpolated set of coordinates will be 
provided to ensure column completeness for mapping. These records can be identified by querying 
where PDC = 0. 
 
Table Content: 
 
The Multiple Enhanced Postal Codes product contains all retired postal codes for a period valid one 
month from the release data.  The structure of the table is the same as the MEP table. 
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Data Dictionary (cont’d) 

CanMap® Postal CodeOM File – Postal to Census Translation Table 

Table Location 

 \MEP\AREAp2c 

 

Table Structure 

Field Name Field Type Field Size Description 

MEP_ID Integer 9 Multiple Enhanced Postal Code point Unique 

Identifier 

PRFEDEA_96 Character 8 Enumeration Area Code for 1996 Census Period 

PRCDDA_01 Character 8 Dissemination Area Unique Identifier for 2001 Census 

Period 

PRCDDA_06 Character 8 Dissemination Area Unique Identifier for 2006 Census 

Period 

PRCDDA_11 Character 8 Dissemination Area Unique Identifier for 2011 Census 

Period 

CMACT_96 Character 10 Census Tract Code for 1996 Census Period 

CTNAME_01 Character 10 Census Tract Unique Identifier for 2001 Census 

Period 

CTNAME_06 Character 10 Census Tract Unique Identifier for 2006 Census 

Period 

CTNAME_11 Character 10 Census Tract Unique Identifier for 2011 Census 

Period 

PRCDCSD_96 Character 7 Uniquely identifies a census subdivision for 1996 

Census Period 

PRCDCSD_01 Character 7 Uniquely identifies a census subdivision for 2001 

Census Period 

PRCDCSD_06 Character 7 Uniquely identifies a census subdivision for 2006 

Census Period 

PRCDCSD_11 Character 7 Uniquely identifies a census subdivision for 2011 

Census Period 

PRCD_96 Character 4 Uniquely identifies a census division for 1996 Census 

Period 

PRCD_01 Character 4 Uniquely identifies a census division for 2001 Census 

Period 

http://www.dmtispatial.com/
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PRCD_06 Character 4 Uniquely identifies a census division for 2006 Census 

Period 

PRCD_11 Character 4 Uniquely identifies a census division for 2011 Census 

Period 

PROV Character 2 2 letter alpha abbreviation (Canada Post) according 

to the first letter of the postal code (e.g. ON) 

PRCDCSD_16 Character 7 Uniquely identifies a census subdivision for 2016 

Census Period 

PRCD_16 Character 4 Uniquely identifies a census division for 2016 Census 

Period 

CTNAME_16 Character 10 Census Tract Unique Identifier for 2016 Census 

Period 

PRCDDA_16 Character 8 Dissemination Area Unique Identifier for 2016 Census 

Period 

PRCDCSD_21 Character 7 Uniquely identifies a census subdivision for 2021 

Census Period 

PRCD_21 Character 4 Uniquely identifies a census division for 2021 Census 

Period 

CTNAME_21 Character 10 Census Tract Unique Identifier for 2021 Census 

Period 

PRCDDA_21 Character 8 Dissemination Area Unique Identifier for 2021 Census 

Period 

 

 

Table Content 

 

The above table contains explicit and unilateral relationships of the 6-digit postal code point geometry to 

various levels of census geography as delineated in the 1996, 2001, 2006, 2011, 2106 and 2021 periods. 

The purpose of the table is to provide a bridge between Canadian postal code points (MEP) and historic 

census geography. 
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Data Dictionary (cont’d) 

CanMap® Postal CodeOM File – Postal to Census Translation Table 
Retired 

Table Location 

 \MEP\AREAp2c_retired 

 

Table Structure 

Field Name Field Type Field Size Description 

MEP_ID Integer 9 Multiple Enhanced Postal Code point Unique 

Identifier 

PRFEDEA_96 Character 8 Enumeration Area Code for 1996 Census Period 

PRCDDA_01 Character 8 Dissemination Area Unique Identifier for 2001 Census 

Period 

PRCDDA_06 Character 8 Dissemination Area Unique Identifier for 2006 Census 

Period 

PRCDDA_11 Character 8 Dissemination Area Unique Identifier for 2011 Census 

Period 

CMACT_96 Character 10 Census Tract Code for 1996 Census Period 

CTNAME_01 Character 10 Census Tract Unique Identifier for 2001 Census 

Period 

CTNAME_06 Character 10 Census Tract Unique Identifier for 2006 Census 

Period 

CTNAME_11 Character 10 Census Tract Unique Identifier for 2011 Census 

Period 

PRCDCSD_96 Character 7 Uniquely identifies a census subdivision for 1996 

Census Period 

PRCDCSD_01 Character 7 Uniquely identifies a census subdivision for 2001 

Census Period 

PRCDCSD_06 Character 7 Uniquely identifies a census subdivision for 2006 

Census Period 

PRCDCSD_11 Character 7 Uniquely identifies a census subdivision for 2011 

Census Period 

PRCD_96 Character 4 Uniquely identifies a census division for 1996 Census 

Period 

PRCD_01 Character 4 Uniquely identifies a census division for 2001 Census 

Period 
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PRCD_06 Character 4 Uniquely identifies a census division for 2006 Census 

Period 

PRCD_11 Character 4 Uniquely identifies a census division for 2011 Census 

Period 

PROV Character 2 2 letter alpha abbreviation (Canada Post) according 

to the first letter of the postal code (e.g. ON) 

PRCDCSD_16 Character 7 Uniquely identifies a census subdivision for 2016 

Census Period 

PRCD_16 Character 4 Uniquely identifies a census division for 2016 Census 

Period 

CTNAME_16 Character 10 Census Tract Unique Identifier for 2016 Census 

Period 

PRCDDA_16 Character 8 Dissemination Area Unique Identifier for 2016 Census 

Period 

PRCDCSD_21 Character 7 Uniquely identifies a census subdivision for 2021 

Census Period 

PRCD_21 Character 4 Uniquely identifies a census division for 2021 Census 

Period 

CTNAME_21 Character 10 Census Tract Unique Identifier for 2021 Census 

Period 

PRCDDA_21 Character 8 Dissemination Area Unique Identifier for 2021 Census 

Period 

 

Table Content 

 

The table contains explicit and unilateral retired relationships of the 6-digit postal code point geometry 

to various levels of census geography as delineated in the 1996, 2001, 2006, 2011, 2016 and 2021 

periods. The purpose of the table is to provide a bridge between Canadian postal code points (MEP) and 

historic census geography.  The table structure is the same as the Postal to Census Transition table 
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Data Dictionary (cont’d) 

CanMap® Postal CodeOM File – Local Delivery Units 

Layer Location 

 \LDU\AREAldu 

 

Layer Structure 

Field Name Field 
Type 

Field 
Size 

Description 

PCA_ID Integer 9 Postal Code Area Unique Identifier (also referred 
to as LDU boundaries) 

POSTALCODE Character 6 Postal Code data with no space between the FSA 
and LDU (i.e. L1R2H2) 

PROV Character 2 2 letter alpha abbreviation (Canada Post) 
according to the first letter of the postal code (i.e. 
L1R2H2 = ON) 

MAF_ID Integer 9 Uniquely identifies a Municipal Amalgamation 
boundary 

PREC_CODE Integer 1 Code indicating the positional accuracy or 
precision of the polygon feature 

PCA_COUNT Integer 5 Total number of Postal Code Area records 
associated with each postal code 

DOM_PCA Integer 1 Dominant Postal Code Area Indicator 

MULTI_PC Integer 1 Multiple Postal Codes Indicator (1 means 
multiple, 0 means single) 

DEL_M_ID Character 6 Dominant delivery mode type and ID. 

LONGITUDE Float  Longitude in decimal degrees 

LATITUDE Float  Latitude in decimal degrees 

 

PCA_ID  
The first two digits of the PCA_ID code reflect the province that the LDU is associated with 
 

PCA_ID  
(2 digits) 

Province 

10 AB 

11 BC 

12 MB 

13 NB 

14 NL 

15 NS 

16 NT 

17 NU 
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18 ON 

19 PE 

20 QC 

21 SK 

22 YT 

 

PREC_CODE (Precision Code)  
 

Precision Code Description 

1 Postal Code Area representing rooftop point addresses. 

2 Postal Code Area representing parcel centroid point 
addresses. 

3 Postal Code Area representing interpolated point addresses 
(High precision). 

4 Postal Code Area representing interpolated point addresses 
(Low precision). 

5 Postal Code Area representing extrapolation based on 
inference in relation to populated place name location 
(Low precision). 

7 Postal Code Area representing extrapolation based on 
manually selected seed points. 

 

 
Layer Content 
 
Postal Code Local Delivery Unit (LDU) boundary is created from CPC postal code address dataset and 
CanMap® Streetfiles. Each postal code is assigned a land parcel on the base of street blocks. 
 
DOM_PCA indicates the dominant postal code boundary with value 1. If there is only one PCA boundary 
corresponding to the postal code, the DOM_PCA has a value of 1. If one postal code has multiple PCA 
boundaries, the boundary, which includes the highest number of addresses, will be given a value of 1.    
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Data Dictionary (cont’d) 

CanMap® Postal CodeOM File – Local Delivery Unit Boundaries Lookup 
Table 

Table Location 

 \LDU\AREAlut 

 

Table Structure 

Field Name Field 

Type 

Field 

Size 

Description 

PCA_ID Integer 9 Postal Code Area Unique Identifier (also referred 

to as LDU boundaries) 

PRIMARY_PC Character 6 Primary Postal Code data with no space between 

the FSA and LDU (i.e. L1R2H2).  The postal code 

value contained within this column will be 

associated with the value in the LDU boundary 

file. 

OTHER_PC Character 6 Other associated Postal Code data with no space 

between the FSA and LDU (i.e. L1R2H2).  These 

are postal codes, which share the same physical 

address as the Primary Postal Code (i.e., the 

postal codes are “stacked” on top of each other). 

 

Table Content 

 

The Local Delivery Unit Boundaries Lookup Table (LUT) provides a link to postal codes where a building 

or discrete area has multiple postal codes. The postal code associated servicing the greatest number of 

addresses (i.e., points of call) is represented in the LDU layer. The non-dominant postal codes are 

retained in the LUT table and are not represented in the Local Delivery Unit (LDU) layer. 

 

Joining the Lookup Table with Local Delivery Unit Boundaries (Postal Code Areas) Table 

 

  The users of LDU Boundary product can obtain the associated postal codes by relating the lookup table 

to the LDU layer with a SQL statement  

 

“XXldu.PCA_ID = XXlut.PCA_ID” (the expression may be different in a specific software). 
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MapInfo example 

 

1. Open the XXldu file 

2. Select ‘Query’ → ‘SQL Select…’ from the Menu 

3. Complete the following query in the SQL Select window:  

SELECT * from XXldu, XXlut WHERE XXlduPCA_ID = XXlutPCA_ID  

 

ArcMap example 

 

1. Right click the XXldu file in the TOC and click Join and Relates→Relate in the context menu 

2. Select PCA_ID in the first box 

3. Type in the full path to XXlut.dbf in the second box and select PCA_ID in the third box 

4. Click OK and the lookup table will be related to the LDU layer 

If a postal code does not exist in the LDU layer, it may be located in the lookup table and then its 

boundary can be found using its corresponding primary postal code in the LDU layer. 
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Data Dictionary (cont’d) 

CanMap® Postal CodeOM File – Forward Sortation Area (FSA) 

Layer Location 

 \FSA\AREAfsa 

  

Layer Structure 

 

Field Name Field Type Field Size Description 

FSA Character 3 Forward Sortation Area 

PROV Character 2 Provincial/Territorial Abbreviation7  

 

Layer Content 

 

The first three characters of a postal code represent the Forward Sortation Area (FSA) indicating a 

geographic area in an urban or rural area.  The first character of the FSA identifies one of the 18 major 

geographic areas, provinces or districts. 

 

FSA boundaries may include multi-polygon regions, for example two or more polygons forming one 

region/entity reflecting the complexity inherent in FSA geography.  Generally, FSA boundaries conform 

to streets, administrative boundaries and other physical features within CanMap®® products. 

 

        Please refer to Appendix C: Understanding Postal Geography for more information. 

  

 
7 For more information refer to Appendix B: Canadian Provincial and Territorial Codes and Abbreviations 
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Appendix A: File Extensions 

ESRI® File Extensions 

 

Refer to the following table for descriptions of ESRI® file extensions.  All file extensions are not available 

for all DMTI products. 

 

File Extension File Description 

*.shp Part of standard ESRI® Shapefile 

*.shx Part of standard ESRI® Shapefile 

*.dbf Part of standard ESRI® Shapefile 

*.sbn Part of Spatial Index 

*.sbx Part of Spatial Index 

*.lyr Layer Properties 

*.prj Datum and Projection Properties 

*.mxd ArcGIS Project file 

 

 

 

MapInfo® Professional File Extensions 

 

Refer to the following table for descriptions of MapInfo file extensions.   

 

File Extension File Description 

*.dat Attribute Data 

*.id Graphic Index 

*.ind Attribute Index 

*.map Graphic Data 

*.tab Tab File 

*.wor Workspace 
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Appendix B: Provincial and Territorial Abbreviations 

The provincial/territorial names and abbreviations reflect those in effect on January 1, 2001 with the 

exception of the name change of the province of Newfoundland and Labrador (previously 

Newfoundland), which came into effect on December 6, 2001.  Newfoundland and Labrador is 

recognized by the alpha code NL (formerly NF). 

 

On April 1, 1999 the Northwest Territories was divided into two territories to create Nunavut Territory.  

On December 18, 2000, Canada Post introduced a new alpha code (NU) for Nunavut.   

 

 

Province/Territory (English) Province/Territory (French) Abbreviation8 

Alberta Alberta AB 

British Columbia Colombie-Britannique BC 

Manitoba Manitoba MB 

New Brunswick Nouveau-Brunswick NB 

Newfoundland and Labrador Terre-Neuve-et-Labrador NL 

Nova Scotia Nouvelle-Écosse NS 

Northwest Territories Territoires du Nord-Ouest NT 

Nunavut Nunavut NU 

Ontario Ontario ON 

Prince Edward Island Île-du-Prince-Édouard PE 

Québec Québec QC 

Saskatchewan Saskatchewan SK 

Yukon  Yukon YT 

 
6 Source: Canada Post Corporation, The Canadian Addressing Guide, October 2002 
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Appendix C:  Understanding Postal Geography 9 

Postal Code Structure 

An integral part of every address in Canada, the postal code was designed to aid in the sorting and 

delivery of mail.  Maintained by the Canada Post Corporation, a postal code is defined as a six-character 

uniformly structured, alphanumeric code in the form “ANA NAN” where “A” represents an alphabetic 

character and “N” represents a numeric character and has two components: the “FSA” and the “LDU”. 

 

example:                         A1A 1A1 

 

 

Forward Sortation Area (FSA) Local Delivery Unit (LDU) 

alpha – numeric – alpha numeric – alpha – numeric 

Forward Sortation Area Boundaries 

The first three characters of a postal code represent the Forward Sortation Area (FSA) indicating a 

geographic area in an urban or rural area.  The first character of the FSA identifies one of the 18 major 

geographic areas, provinces or districts.  Refer to Figure 1 on following page. 

  

 
9 Source: Canada Post Corporation, 2003 
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First 

Letter of 

FSA 

 

 

Geographic Area  

A Newfoundland & Labrador 

B Nova Scotia 

C Prince Edward Island 

E New Brunswick 

G Quebec (east) 

H Québec (metropolitan Montréal) 

J Quebec (west) 

K Ontario (east) 

L Ontario (central) 

M Ontario (metropolitan Toronto) 

N Ontario (southwest) 

P Ontario (northern) 

R Manitoba 

S Saskatchewan 

T Alberta 

V British Columbia 

X Northwest Territories/Nunavut 

Y Yukon Territory 

 

 

 

The second numeric character (numerals 0-9) of the FSA Boundary identifies either an urban postal code 

or a rural postal code.  Rural postal codes are represented by the numeral 0 (zero), for example A0A, and 

are serviced by rural route drivers and/or postal outlets. Urban postal codes are represented by the 

numerals 1 to 9, for example E2J, and are generally serviced by letter carriers or community mailboxes.   

 

The third character of the FSA segment, in conjunction with the first two characters, describes an area of 

a city or town or other geographic area. 

 

Local Delivery Unit (LDU) 

 

The last three characters represent the Local Delivery Unit (LDU) identifying a specific business or 

residential point of delivery located within an FSA.  

Figure 1: FSA areas in Canada represented by the first letter   
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Appendix D: Creating Unique Enhanced Postal Codes from 

Multiple Enhanced Postal Codes 

Multiple Enhanced Postal Codes contain every occurrence of a particular postal code, including the most 

representative, or dominant, point for a postal code.  Unique Enhanced Postal Codes only contain the 

dominant postal code points. The Multiple Enhanced Postal Code product contains a field called ‘SLI’, or 

Single Link Indicator.  This field flags each postal code record for dominance, or greatest representation.  

If the record is the dominant, or most representative, point it is given a ‘1’ in the SLI field.  All other 

records for the postal code are given a ‘0’ SLI value.  This means the Unique Enhanced Postal Code 

product can in fact be created from the Multiple Enhanced product by querying out the dominant postal 

code records. 

For the MapInfo format: 

1. Open the AREAmep data file in MapInfo. 

2. Select ‘Query’ → ‘SQL Select…’ from the Menu 

3. Complete the following query in the SQL Select window→ Select * from AREAmep where SLI = 1  
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4. Select ‘File’ → ‘Save Copy As…’ from the Menu 

5. Choose your CANuep query and click ‘Ok’. 

6. Type in an appropriate file name and click ‘Save’. 

 

For the ArcGIS Shapefile format: 

1. With a session of ArcMap open, click on the ‘Add Data’          button to select the AREAmep.shp. 

2. With the layer now displayed in the Data view, go to ‘Selection’ > ‘Select By Attributes’ in the 

main Menu. 

3. Add the statement SLI = 1 using the Query functions and ensure that ‘Create a new selection’ is 

the Method. Click ‘OK’ 

 
4. When the selection is complete, Right click the layer > ‘Selection’ > ‘Create Layer From Selected 

Features’ – The selected features will be added as its own layer to the Table of Contents. 

5. Right Click on this selection layer and go to Data > ‘Export Data’ and save All Features as 

AREAuep – this will create a new shape file based on your selection. 

6. Finally, you will also be prompted to add the new shape file as a layer to the map. 
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Appendix E: Creating High Precision MEP Points 

The Multiple Enhanced Postal Codes contain two sets of coordinates.  By default, the MEP are spatially 

enabled with the values in the LONGITUDE and LATITUDE columns which represent routable and 

interpolated locations.  To create points for high precision locations where available and interpolated 

where not available, the steps below can be followed to reference the HP_LONG and HP_LAT 

coordinates. 

 

For the MapInfo format: 

1. You can opt to work on a copy of the file to have two spatial versions of the MEP. 

2. Open the AREAmep data file in MapInfo.  

3. Select ‘Table’ → ‘Create Points…’ from the Menu 

 
4. For the ‘Create Points for Table’ option, make sure that your AREAmep table is selected. 

5. Set the Symbol of your choice. 

6. Select HP_LONG for the X Coordinates and HP_LAT for the Y Coordinates. 

7. Verify the Projection, which should be Longitude/Latitude (WGS84). 
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8. Check the box to ‘Overwrite existing points’.  

9. Hit OK to complete the process. 

 

 

 

For the ArcGIS Shapefile format: 

1. Make a copy of the DBF portion of the AREAmep shapefile in Windows Explorer. 

2. In a session of ArcMap open, select the Add XY data     option either under 

Tools or the File menu depending on the version of ArcGIS.  

3. In the Add XY Data window, navigate to and choose the DBF copy made in step 1 as the table. 

4. Select HP_LONG as the X Field and HP_LAT as the Y field.   

5. Under the Coordinate System, go to Edit > Import and select the original AREAmep Shapefile > 

click OK. 

6. With the parameters shown as below, click ‘OK’ and wait for the point Events to be created. A 

new layer will be added to the Table of Contents. 
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7. Right click the newly created Events layer, go to Data > Export Data and Save the new shape file 

to your chosen location with a new name. 

8. Finally, you will also be prompted to add the new shape file as a layer to the map. 
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Appendix F: Postal Geography FAQ 

Q: Why is there more than one postal code at the same location in MEP and LDU? 

A: There are a number of scenarios where “stacking” can occur where there is more than one 

postal code at a specified x,y location. 

 

These scenarios can include:  

➢ Locations of large office or apartment buildings, where different floors of the same building 

are assigned separate postal codes 

➢ In MEP, postal code points with a POSITION code of 3, 4 or 5 (LDU/FSA/PPN) all fall to the 

same centroid value.  These are postal codes that are either unaddressed (e.g.: Lock boxes or 

P.O. Boxes) or cannot be presently geocoded to a specific point on a street network. 

 

NOTE: “Stacked” postal codes in the LDU product are accounted for in the Local Delivery Unit Boundaries 

Lookup Table 

 

Q:  Why are there postal codes in the incorrect province? 

A: There are instances where postal codes fall outside of their correct province but are still 

considered   valid.   

➢ Some municipalities cross provincial borders yet retain the postal code(s) assigned to the 

municipality.  For example this scenario occurs in Flin Flon, SK. 

 

Q: Why are there postal codes outside their appropriate FSA boundary? 

A: DMTI Spatial™ creates FSA boundaries based on a point-in-polygon statistical analysis of the 

postal code product.  While the largest clusters of points are captured, some postal codes may be 

located outside their appropriate FSA boundaries. Here are a few reasons why this occurs: 

➢ Anomalies within postal geography or conflicts within postal geography and the census 

geography that defines municipal names and boundaries 

➢ Some postal codes fall outside their “correct” FSA boundaries due to administrative 

considerations. For example, several Federal government offices assigned Ottawa postal 

codes (an FSA of K1A), but are actually located in Hull, Quebec. 

➢ Postal codes can also be mislocated due to simple addressing anomalies based on Canada 

Post data used to create postal codes. For example, Lakeland College institution in 

Lloydminster, Alberta has a postal code of “S9V 1Z3”.  The first letter of the FSA, “S”, refers 

to a Saskatchewan postal code. 

➢ For the MEP product, when geocoding we try to get the best street level position possible 

within certain logical thresholds.  This allows us to place the MEP point to its most 

representative location achieving a higher precision than placing it to LDU, FSA or PPN 
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centroid.  As a result, the MEP point may fall just outside of its FSA, but will be closer to its 

true position. 

 

The anomalies described above are typically not an issue in the operation of the postal system providing 

that mail is delivered to the intended recipients. However, in geographic analysis, where strict spatial 

analysis rules are enforced, these types of “gray area” anomalies can sometimes be more difficult to 

accommodate.     

 

Q:         Why are there MEP points not falling in their appropriate LDU boundary? 

A:         In most cases the MEP points will fall into their corresponding LDU boundary.  When this is not 

the case: 

 

➢ The postal code in the MEP product might be in the Local Delivery Unit Boundaries Lookup 

Table related to the LDU postal code or 

➢ The MEP point has a POSITION value of 4 or 5 which is a centroid position and is not related 

to the LDU or 

➢ The MEP point was geocoded to the closest address on the street with which the Postal code 

serves.  This allows us to place the MEP point to its most representative location achieving a 

higher precision than placing it to LDU, FSA or PPN centroid.  As a result the MEP might fall 

outside of its appropriate LDU, but will be closer to its true position. 

 

Q Why are there LDU boundaries with no MEP point? 

A: The MEP product is a point file representing ranges of addresses served by one Postal code. The 

LDU product is a polygon file representing individual addresses delineated by roads, water bodies and 

parks.  Given these differences, there will not be an MEP point in each LDU boundary since a range of 

addresses in MEP can be broken up into several LDU boundaries dependant on the topology of the area. 

 

Q: How do I create Postal Route maps by using the DEL_M_ID field in LDU? 

A: Postal Route maps provide a representation of mail delivery routes.  This information is best 

viewed by altering the symbology of the LDU product.  Simply symbolize your data with a colour scheme 

based on the DEL_M_ID field to view this information on your map. 

 

Q:  Why are there ‘holes’ in the LDU boundary file? 

A: There are two instances where the LDU product will contain no data. They are the following: 

 

➢ DMTI Spatial™ creates LDU boundaries based around topographical inputs.  Parks, water 

bodies and roads are not included in the LDU polygon fabric. No LDU polygons will be 

created where these phenomena occur. 

➢ LDU boundaries are based off of address points from Canada Post.  In some areas we might 

not yet have LDU boundaries for addressed areas.  This is usually a case where either Canada 
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Post’s addresses do not match our CanMap®  Streetfiles addressing or we are working on 

obtaining and integrating new sources into our Streetfiles. As sources are continually 

acquired and integrated into our CanMap Streetfiles, we can further enhance the 

completeness of our LDU product. 

 

Q: I cannot find the postal code I am looking for? 

A: There are two reasons why you cannot find your postal code in the LDU product: 

 

➢ The postal code might be in the Postal code Lookup Table.  This table links to a postal code in 

the LDU product giving the postal code in the lookup table a spatial location.  Basic GIS 

topology rules do not allow multiple polygons on top of each other.  Please see Local 

Delivery Units Boundary Lookup Table for more information on how to link a postal code in 

the Lookup table to the LDU product. 

➢ The postal code you are looking for might not currently be available in the LDU product for 

one of two reasons: 

• Canada Post’s postal code data is only valid for one month following its release.  

Given this, the postal codes in the LDU product may not be an exhaustive list. 

• DMTI may not have all active postal codes represented in the LDU product.  As we 

continue to obtain sources, we will gain the ability to incorporate any missing postal 

codes into the product. 

 

Q: Why are some DAs not present in the P2C table? 

A: The P2C (Postal to Census) table represents StatsCan information for MEPs (Multiple Enhanced 

Postal Codes) using a point-in-polygon operation.  This means that if a DA is not present in the 

table, there are no MEPs that fall within those DAs. 

 

Q: Why aren’t ESRI locators functioning correctly (MEPs and UEPs)? 

A: The locators were generated using ArcMap 10.x.  ArcGIS will display an error if these locators are 

used in earlier ESRI versions.  The user must install ArcMap 10.1 with Service Pack 1 or higher in 

order for the locator to function without error.  See the following link for a more detailed 

description of the problem: 

http://support.esri.com/em/knowledgebase/techarticles/detail/42971  

 

Q: Why do some FSAs appear to be disjoint? 

A: With new and changing postal codes every month, FSAs shapes and sizes are changing and 

competing for space.  Consequently, some polygons may have multiple occurrences that are 

disjoint.  See screenshot on following page for an example: 
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Note:  The MEP product contains all Active postal codes for a period valid one month from the release 

data.  Please refer to this product for a list of Active and Retired postal codes to further verify the validity 

of the postal code you are looking for. 

 
Q: Are all MEP’s included in the LDU product? 

A: No, inferred postal codes within the MEP product are not included in the LDU product. Inferred 

postal codes in the MEP product are instead based on references to other corresponding postal 

code(s). Therefore, there could be multiple inferred postal codes in the MEP product that are 

referring to the same location, as they can all be an alias to a main postal code, and thus not 

included in the LDU postal code product. 

 

Q: Do postal code polygons conform to topology rules? 

A: Postal code polygons are processed with an XY tolerance of 0.000001 decimal degrees. They are 

free of overlaps and self-intersections.   
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Appendix G: ISO 19115:2003 Compliant Metadata 

Metadata Notification 

 

As of May 15th 2005, DMTI Spatial data products have metadata that are IS0 19115:2003 compliant.  

 

This product now includes structured metadata files as provided in XML and/or HTM format. These 

metadata files reside with the graphic or database files to which they are associated. It is recommended 

that users review and customize the metadata as per their specific needs. 

 

This latest addition to the CanMap® line of products is another enhancement that will benefit our users 

and increase overall product satisfaction. 
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